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MITSUBISHI Electric Corporation 

MELSEC AnA/AnU Series  

Computer Link Driver 
 Supported version TOP Design Studio V1.0 or higher  

 

CONTENTS 

We would like to thank our customers for using M2I's "Touch 

Operation Panel (M2I TOP) Series". Read this manual and familiarize 

yourself with the connection method and procedures of the “TOP and 

external device”. 

 

 

 

1. System configuration Page 2 

 

 

Describes the devices required for connection, the setting of 

each device, cables, and configurable systems. 

2. External device selection  Page 3 

 Select a TOP model and an external device. 

3. TOP communication setting Page 4 

 Describes how to set the TOP communication. 

4. External device setting Page 9 

 Describes how to set up communication for external devices. 

5. Cable table Page 11 

 Describes the cable specifications required for connection. 

6. Supported addresses Page 13 

 Refer to this section to check the addresses which can 

communicate with an external device. 
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1. System configuration 

The system configuration of TOP and “MITSUBISHI Electric Corporation - MELSEC AnA/AnU Computer Link” is as follows: 

 

Series CPU Link I/F 
Communication 

method 
System setting Cable 

MELSEC-

AnA/AnU 

A2ACPU  

A2ACPU-S1 

A3ACPU  

A2UCPU  

A2UCPU-S1  

A3UCPU  

A4UCPU 

AJ71C24-S6  

AJ71C24-S8 

RS-232C 

3. TOP communication 

setting 

4.1. External device 

setting 1 

5.1. Cable table 1 

RS-422 ( 4 wire ) 

AJ71UC24 

RS-232C 

RS-422 ( 4 wire ) 

A2USCPU  

A2USHCPU-S1 

A1SJ71C24-R2  

A1SJ71UC24-R2 
RS-232C 

3. TOP communication 

setting 

4.2. External device 

setting 2 

5.2. Cable table 2 
A1SJ71C24-R4  

A1SJ71UC24-R4 
RS-422 ( 4 wire ) 

 

 

■ Connection configuration 

 

ㆍ1:1 (one TOP and one external device) connection – configuration which is possible in RS232C/422/485 communication. 

 

 

ㆍ1:N (one TOP and multiple external devices) connection – configuration which is possible in RS422/485 communication. 
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2. External device selection 

■ Select a TOP model and a port, and then select an external device. 
 

 

 
 

 
 

 

Settings Contents 

TOP Model Check the TOP display and process to select the touch model. 

External device Vendor Select the vendor of the external device to be connected to TOP. 

Please select “MITSUBISHI Electric Corporation”. 

PLC Select an external device to connect to TOP. 
 

Model Interface Protocol 

MELSEC AnA/AnU Series Computer Link MC Protocol 1C ACPU 
 

Please check the system configuration in Chapter 1 to see if the external device you want to 

connect is a model whose system can be configured. 

Supported Protocol 

MC Protocol 1C Format 1 
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3. TOP communication setting 

The communication can be set in TOP Design Studio or TOP main menu. The communication should be set in the same way as that 

of the external device. 
 

3.1 Communication setting in TOP Design Studio 

(1) Communication interface setting 

■ [Project > Project Property > TOP Setting] → [Project Option > “Use HMI Setup” Check > Edit > Serial] 

– Set the TOP communication interface in TOP Design Studio. 

 
 

 
 

Items TOP External device Remarks 

Signal Level (port) 
RS-232C RS-422 

RS-232C 

RS-422 
 

Baud Rate 19200  

Data Bit 8  

Stop Bit 1  

Parity Bit None.  

* The above settings are examples recommended by the company. 

 

Items Description 

Signal Level Select the serial communication method between the TOP and an external device.  

Baud Rate Select the serial communication speed between the TOP and an external device. 

Data Bit Select the serial communication data bit between the TOP and an external device. 

Stop Bit Select the serial communication stop bit between the TOP and an external device. 

Parity Bit Select the serial communication parity bit check method between the TOP and an external device. 
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 (2) Communication option setting 

■ [Project > Project Property > Device Setting > COM > “PLC1 : MELSEC-AnA/AnU Series”] 

– Set the options of the MELSEC AnA/AnU Series Computer Link communication driver in TOP Design Studio. 

 

 

Items Settings Remarks 

Interface Select “Computer Link”. Refer to “2. External 

device selection”. Protocol Select “MC Protocol 1C ACPU”. 

TimeOut (ms) Set the time for the TOP to wait for a response from an external device.  

SendWait (ms) Set the waiting time between TOP’s receiving a response from an external device and 

sending the next command request. 
 

Station Num Enter the prefix of an external device.  

PC No Set the prefix of TOP.  
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3.2. Communication setting in TOP  

* This is a setting method when "Use HMI Setup" in the setting items in "3.1 TOP Design Studio" is not checked. 
 

■ Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen. 

   

(1) Communication interface setting 

■ [Main Screen > Control Panel > Serial] 
 

 

Items TOP External device Remarks 

Signal Level (port) 
RS-232C RS-422 

RS-232C 

RS-422 
 

Baud Rate 19200  

Data Bit 8  

Stop Bit 1  

Parity Bit None.  

* The above settings are setting examples recommended by the company. 
 

Items Description 

Signal Level Select the serial communication method between the TOP and an external device.  

Baud Rate Select the serial communication speed between the TOP and an external device. 

Data Bit Select the serial communication data bit between the TOP and an external device. 

Stop Bit Select the serial communication stop bit between the TOP and an external device. 

Parity Bit Select the serial communication parity bit check method between the TOP and an external device. 
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 (2) Communication option setting 

■ [Main Screen > Control Panel > PLC] 
 

 

 

Items Settings Remarks 

Interface Select “Computer Link”. Refer to “2. External 

device selection”. Protocol Select “MC Protocol 1C ACPU”. 

TimeOut (ms) Set the time for the TOP to wait for a response from an external device.  

SendWait (ms) Set the waiting time between TOP’s receiving a response from an external device and 

sending the next command request. 
 

Station Num Enter the prefix of an external device.  

PC No Set the prefix of TOP.  
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3.3 Communication diagnostics 

■ Check the interface setting status between the TOP and an external device. 

- Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen. 

- Check if the port (COM1/COM2) settings you want to use in [Control Panel > Serial] are the same as those of the external device. 

 

■ Diagnosis of whether the port communication is normal or not 

- Touch "Communication diagnostics" in [Control Panel > PLC]. 

- The Diagnostics dialog box pops up on the screen and determines the diagnostic status. 

OK Communication setting normal 

Time Out Error Communication setting abnormal 

- Check the cable, TOP, and external device setting status. (Reference: Communication diagnostics sheet) 

 

■ Communication diagnostics sheet 

- If there is a problem with the communication connection with an external terminal, please check the settings in the sheet below. 

Items Contents Check Remarks 

System 

configuration 

How to connect the system OK NG 
1. System configuration 

Connection cable name OK NG 

TOP Version information OK NG 

2. External device selection 

3. Communication setting 

Port in use OK NG 

Driver name OK NG 

Other detailed settings OK NG 

Relative prefix Project setting OK NG 

Communication 

diagnostics 
OK NG 

Serial Parameter Transmission 

Speed 
OK NG 

Data Bit OK NG 

Stop Bit OK NG 

Parity Bit OK NG 

External device CPU name OK NG 

4. External device setting 

Communication port name (module name) OK NG 

Protocol (mode) OK NG 

Setup Prefix OK NG 

Other detailed settings OK NG 

Serial Parameter Transmission 

Speed 
OK NG 

Data Bit OK NG 

Stop Bit OK NG 

Parity Bit OK NG 

Check address range  

OK NG 

6. Supported addresses 

(For details, please refer to the PLC 

vendor's manual.) 
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4. External device setting 

4.1 External device setting 1 (AJ71C24, AJ71UC24) 

Configure the communication settings using the DIP Switch of the serial communication unit. For a more detailed setting method 

than that described in this example, refer to the PLC user manual. 
 

 
Serial communication unit’s RUN LED must be ON for communication to be possible. 

 

  

Step 1. Configure the communication protocol format by configuring the Mode Setting Rotary 

Switch as shown below. 

Signal 

Level 

Settings Settings 

RS-232C 1 Protocol mode format 1 

RS-422 5 Protocol mode format 1 

* Use switch settings 1 and 5 for RS-232C and RS-422, respectively 

Step 2. Configure the communication setting for the Dip Switch. 

■ AJ71C24 

DIP 

Switch 

Settings ON OFF Examples of 

setting *Note 1) 

SW11 Select communication channel  RS-422 RS-232C OFF 

SW12 Data bit configuration 8 7 ON 

  

Transmission speed 

configuration 

2400 4800 9600 19200 Not 

used 

 

SW13 ON OFF ON OFF ON OFF 

SW14 ON OFF OFF ON ON ON 

SW15 OFF ON ON ON ON ON 

SW16 Parity bit configuration Valid Null OFF 

SW17 Parity bit configuration Even Odd OFF 

SW18 Stop bit configuration  2 1 OFF 

SW21 BCC configuration Valid Null ON 

SW22 WRITE configuration during RUN  Yes No ON 

SW23 Transmission-side terminal resistance Valid Null OFF 

SW24 Reception-side terminal resistance Valid Null OFF 

*Note 1) Settings: Signal “RS-232C” / Speed “19200bps” / Data ”8bit” / Stop “1bit” / Parity “None” 

■ AJ71UC24 

DIP 

Switch 

Settings ON OFF Examples of 

setting *Note 1) 

SW11 Select communication channel  RS-422 RS-232C OFF 

SW12 Data bit configuration 8 7 ON 

  

Transmission speed 

configuration 

2400 4800 9600 19200 Not 

used 

 

SW13 ON OFF ON OFF ON OFF 

SW14 ON OFF OFF ON ON ON 

SW15 OFF ON ON ON ON ON 

SW16 Parity bit configuration Valid Null OFF 

SW17 Parity bit configuration Even Odd OFF 

SW18 Stop bit configuration  2 1 OFF 

SW21 BCC configuration Valid Null ON 

SW22 WRITE configuration during RUN  Yes No ON 

SW23 Calculator link Computer Link Multiple Drop 

Link 

ON 

SW24 Not used 

*Note 1) Settings: Signal “RS-232C” / Speed “19200bps” / Data ”8bit” / Stop “1bit” / Parity “None” 
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Step 3. Configure the communication card prefix by configuring the Station Setting Rotary 

Switch as shown below. 

Station Setting Rotary Switch Settings 

X10 0 Configure serial communication card 

prefix as “0” X1 0 
 

Step 4. Restart the power after configuring the Dip Switch. 

4.2 External device setting 2 (A1SJ71C24, A1SJ71UC24) 

Configure the communication settings using the DIP Switch of the serial communication unit. For a more detailed setting method 

than that described in this example, refer to the PLC user manual. 
  

 
Serial communication unit’s RUN LED must be ON for communication to be possible. 

 

 

Step 1. Configure the communication protocol format by configuring the Mode Setting Rotary 

Switch as shown below. 

Signal 

Level 

Settings Settings 

RS-232C 1 Protocol mode format 1 

RS-422 5 Protocol mode format 1 

* Use switch settings 1 and 5 for RS-232C and RS-422, respectively 

Step 2. Configure the communication setting for the Dip Switch as shown below. 

DIP 

Switch 

Settings ON OFF Examples of 

setting *Note 

1) 

SW01 Not used 

SW02 Calculator link Computer Link Multiple Drop 

Link 

ON 

SW03 Not used 

SW04 WRITE configuration during RUN Yes No ON 

 Transmission speed 

configuration 

2400 4800 9600 19200 Not 

used 

 

SW05 ON OFF ON OFF ON OFF 

SW06 ON OFF OFF ON ON ON 

SW07 OFF ON ON ON ON ON 

SW08 Data bit configuration 8 7 ON 

SW09 Parity bit configuration Valid Null OFF 

SW10 Parity bit configuration Even Odd OFF 

SW11 Stop bit configuration  2 1 OFF 

SW12 BCC configuration Valid Null ON 

*Note 1) Settings: Speed “19200bps” / Data ”8bit” / Stop “1bit” / Parity “None” 

Step 3. Configure the communication card prefix by configuring the Station Setting Rotary 

Switch as shown below. 

Station Setting Rotary Switch Settings 

X10 0 Configure serial communication card prefix as “0” 

X1 0 
 

Step 4. Restart the power after configuring the Dip Switch. 
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5. Cable table 

This chapter introduces a cable diagram for normal communication between the TOP and the corresponding device. 

(The cable diagram described in this section may differ from the recommendations of “Mitsubishi Electric Corporation”) 

5.1 Cable table 1 (AJ71C24, AJ71UC24) 
 

■ RS-232C (1:1 connection) 

COM 

Cable connection 

PLC 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

CD 1  1 FG 

 

Based on 

communication 

cable connector 

front, 

D-SUB 25 Pin male 

(male, convex) 

RD 2 2 SD 

SD 3 3 RD 

DTR 4 4 RTS 

SG 5 5 CTS 

DSR 6 6 DSR 

RTS 7 7 SG 

CTS 8 8 CD 

 9 20 DTR 

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

 

■ RS-422 (1:1 connection) 

COM 

Cable connection 

PLC 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Signal 

name 
Pin arrangement 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

RDA 1  SDA 

 

 2 SDB 

 3 RDA 

RDB 4 RDB 

SG 5 SG 

SDA 6  

 7  

 8  

SDB 9  

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

 

 

■ RS-422  (1:N connection) – Refer to 1:1 connection to connect in the following way. 

TOP 
Cable connection and signal direction 

PLC Cable connection and signal 

direction 

PLC 

Signal name Signal name Signal name 

RDA 

 

SDA 

 

SDA 

RDB SDB SDB 

SDA RDA RDA 

SDB RDB RDB 

SG SG SG 
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5.2 Cable table 2 (A1SJ71C24, A1SJ71UC24) 
 

■ RS-232C (1:1 connection) 

COM 

Cable connection 

PLC 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

CD 1  1 CD 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

SD 2 2 RD 

RD 3 3 SD 

DTR 4 4 DTR 

SG 5 5 SG 

DSR 6 6 DSR 

RTS 7 7 RTS 

CTS 8 8 CTS 

 9 9  

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 
 

■ RS-422 (1:1 connection) 

COM 

Cable connection 

PLC 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Signal 

name 
Pin arrangement 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

RDA 1  SDA 

 

 2 SDB 

 3 RDA 

RDB 4 RDB 

SG 5 SG 

SDA 6  

 7  

 8  

SDB 9  

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

 

 

■ RS-422  (1:N connection) – Refer to 1:1 connection to connect in the following way. 

TOP 
Cable connection and signal direction 

PLC Cable connection and signal 

direction 

PLC 

Signal name Signal name Signal name 

RDA 

 

SDA 

 

SDA 

RDB SDB SDB 

SDA RDA RDA 

SDB RDB RDB 

SG SG SG 
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6. Supported addresses 

The devices available in TOP are as follows:  

The device range (address) may differ depending on the CPU module series/type. The TOP series supports the maximum address 

range used by the external device series. Please refer to each CPU module user manual and be take caution to not deviate from the 

address range supported by the device you want to use. 

 

Type Remarks Bit-designated address Word-designated address 

Input Bit X0000 – X1FFF X0000 – X1FF0 

Output Bit Y0000 – Y1FFF Y0000 – Y1FF0 

STEP relay Bit S0000 - S2047 

 

Special relay Bit F0000 – F2047 F0000 – F2032 

LATCH relay Bit L0000 – L8191 

 

Internal relay Bit M0000 – M8191 M0000 – M8176 

Special relay Bit M9000 - M9255 M9000 – M9240 

Timer - Coil Bit TC000 - TC2047  

Timer - Contact Bit TS0000 – TS2047 

 

Timer-Current value Word  TN000 – TN2047 

Counter - Coil Bit CC000 – CC1023  

Counter - Contact Bit CS000 – CS1023  

Counter-Current value Word 

 

CN000 – CN1023 

LINK relay Bit B0000 – B1FFF B0000 – B1FFF 

LINK register Word W0000.0 – W1FFF.F W0000 – W1FFF 

Data register Word D0000.0 – D8191.15 D0000 – D8191 

Special register Word D9000.0 - D9255.15 D9000 - D9255 

 


